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BAB III 

METODE PENELITIAN 

 

3.1 Metode dan Desain Penelitian 

Desain penelitian sangat dibutuhkan dalam sebuah penelitian, karena akan 

memberikan petunjuk bagaimana penelitian tersebut harus dilaksanakan. Di dalam 

metode penelitian akan ditemukan cara-cara bagaimana objek penelitian yang dituju 

bisa diketahui dan diamati sehingga menghasilkan data-data yang tepat sesuai dengan 

tujuan penelitian. Artinya penggunaan metode penelitian bergantung kepada 

permasalahan dan pertanyaan penelitian yang muncul. 

Pada metode penelitian eksperimen, didalamnya terdapat beberapa bentuk desain 

penelitian. Desain penelitian yang digunakan dalam penelitian ini adalah Pretest-

Posttest Control Group Design With More Than One Experimental Group. 

Penggunaan desain tersebut disesuaikan dengan karakteristik penelitian serta pokok 

permasalahan yang dibahas dalam penelitian ini. Penelitian yang digunakan 

merupakan quasi-experimental design (eksperimen semu) yaitu jenis eksperimen 

yang menggunakan seluruh subjek yang utuh (intact group) untuk diberikan 

perlakuan (treatment). (Fraenkel et al., 2013) menjelaskan “A Type of experimental 

design in which the researcher does not use random assignment of subject to group.” 

Menurut Johnson dan Christensen (2014, hlm. 303) bahwa, 

“Pretest-Posttest Control Group Design With More Than One Experimental 

Group as an excellent experimental design with more than one experimental 

design because it does an excellent job of controlling for rival hypotheses that 

would threaten the interval validity of the experimrnt.”  

 

Pada penelitian ini peneliti menerapkan 2 (dua) perlakuan pada 2 (dua) kelompok 

eksperimen dan aktivitas pada 1 (satu) kelompok kontrol. Seperti yang dijelaskan 

oleh (Christensen, Johnson, & Turner, 2015) bahwa “This design could be, and 

frequently is, expanded to include more than one experimental group.” Gambaran 

mengenai design tersebut dapat dilihat pada tabel 3.1 yaitu pada halaman 24: 
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Tabel 3.1 

Design Pretest-Posttest Control Group Design With More Than One 

Experimental Group 

 

 

 

 

 

 

Sumber: Christesen, Jhonson, & Turner (2015, hlm. 304) 

 

Keterangan: 

      =   Pretest emotional intelligence. 

      =   Posttest emotional intelligence. 

XC   = Aktivitas Ekstrakulikuler Akademis 

     = Treatment aktivitas olahraga (ekstrakulikuler bola voli dengan integrasi 

emotional intelligence) 

     = Treatment aktivitas olahraga (ekstrakulikuler bola voli) 

 

Pada penelitian ini sampel yang digunakan yaitu Purposive Sampling, yaitu 

pengambilan sampel yang memiliki karakteristik tertentu dari populasi yang diambil, 

kemudian “O” adalah observasi atau pengukuran dilakukan pada saat pretest dan 

posttest, “XT1 dan XT2” adalah kelompok Eksperimen dengan aktivitas 

ekstrakulikuler bola voli, dan “Xc” adalah kelompok kontrol dengan ekstrakulikuler 

akademis. (Fraenkel et al., 2013) mengatakan bahwa, “The control group almost 

always receives a different treatment of some sort”. Kelompok kontrol hampir selalu 

menerima perlakuan yang berbeda dengan kelompok Eskperimen. “An experiment 

usually involves two groups of subjects, an experimental group and a control or a 

comparison group”, (Fraenkel et al., 2013). Pada penelitian eksperimen, di dalamnya 

terdapat dua kelompok subjek, yaitu kelompok eksperimen dan kelompok kontrol 

atau kelompok pembanding.  

Pretest  Treatment Posttest 

Control group  𝐎𝟏  XC  𝐎𝟐 

Experimental group 1 𝐎𝟏  𝐗𝐓𝟏  𝐎𝟐 

Experimental group 2 𝐎𝟏  𝐗𝐓𝟐  𝐎𝟐 
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“The experimental group receives a treatment of some sort (such as a next 

textbook or a different method of teaching), while the control group receives no 

treatment (or the comparison group receives a different treatment)” (Fraenkel et 

al., 2013).  

 

Implikasinya adalah penelitian eksperimen merupakan sebuah penelitian yang 

unik dan berbeda dengan metode peneltian yang lainnya, karena dalam penelitian ini, 

peneliti dapat dengan bebas menetukan independen variabel yang ingin digunakan 

untuk mempengaruhi dependen variabel. 

Dalam penelitian ini, terdapat partisipan yang akan membantu kelancaran serta 

proses penelitian, guna tercapainya tujuan dari penelitian itu sendiri, baik dalam 

pengambilan data, pengolahan data, hingga akhir dari penelitian itu sendiri (Fraenkel, 

Wallen, & Hyun, 2013). Pakar : Berperan sebagai pendefinisi dan pengarah yang bisa 

membatasi kemana arahan penelitian yang sedang dilakukan (Fraenkel et al., 2013).  

Objek : Objek penelitian disini merupakan target utama dalam penelitian yang 

bukanlah artian dari objek sesungguhnya, tetapi subjek (orang) yang sementara di 

anggap sebagai objek dengan kredibilitas sesuai dengan kebutuhan penelitian, dengan 

tidak melakukan pemaksaan, membuktikan sesuatu, menceramahi, menggurui, tetapi 

memberikan sebuah pengertian dengan cara memberikan pengalaman dan empatis 

yang bermanfat bagi orang tersebut (Fraenkel et al., 2013). 

 

3.2 Tempat dan Waktu Penelitian 

Tempat dan waktu : Merupakan ruang yang dibutuhkan untuk melakukan semua 

keperluan penelitian, baik dalam satu tempat maupun tempat yang terpisah pisah, 

karena bersifat sementara tetapi mampu memberikan makna melalui ruang dan waktu 

yang bisa membantu penelitian tetap mengarah kepada tujuan penelitian (Fraenkel et 

al., 2013) 

Untuk mencapai suatu tujuan yang diinginkan dalam sebuah pelaksanaan 

penelitian, maka diperlukan suatu prosedur yang tepat. Penerapan prosedur yang 

tepat, tentunya tujuan dari penelitian yang telah ditentukan dapat tercapai. Untuk 

mencapai semua tujuan tersebut diperlukan suatu persiapan yang matang. Ada pun 
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persiapan yang dilakukan dalam penelitian ini yaitu tempat penelitian yang akan 

dilaksanakan di: 

1. Pelaksanaan penelitian ini bertempat di : 

SMP NU Kaplongan, Indramayu. 

2. Waktu penelitian dilakukan 3 kali per minggu dengan jenis permainan Bola Voli, 

60 menit per waktu, dan melanjutkan pelatihan selama 4 minggu. 1 pertemuan 

untuk pretest, 10 pertemuan untuk pemberian perlakuan atau pelatihan sampai 

berakhir, dan langkah selanjutnya adalah 1 untuk pelaksanaan untuk posttest, 

sehingga total pertemuan yang dilakukan adalah 12 pertemuan (Struyven, Dochy, 

& Janssens, 2010; Digelidis & Papapavlou, 2014). 

 

3.3  Subjek Penelitian 

Dalam penelitian ini, subjek penelitian merupakan sesuatu yang memiliki 

kedudukan yang sangat penting. Karena dalam subjek inilah data tentang variabel 

yang diteliti berada pada subjek yang diteliti. Dalam proses dilapangan, untuk 

menentukan siapa yang akan diberi perlakuan akan digunakan teknik sampling yang 

sesuai dengan kondisi lapangan. Subjek penelitian dapat dilakukan dengan cara 

menentukan populasi dan sampel. Subjek dalam penelitian ini adalah siswa SMP NU 

Kaplongan, Indramayu. 

 

3.4  Populasi dan Sampel 

Populasi dan sampel merupakan bagian terpenting bagi berjalannya suatu 

penelitian, menurut (Fraenkel et al., 2013, hlm. 91) “A sample in a research study is 

the group on which information is obtained. The larger group to which one hopes to 

apply the results is called the population”.  Yang berarti bahwa suatu sampel dalam 

penelitian merupakan kelompok yang diperoleh berdasarkan informasi, sedangkan 

kelompok yang lebih besarnya lagi dinamakan populasi. Dalam penelitian ini, teknik 

sampling yang digunakan yaitu purposive sampling.  



 
 

Nur Mahfuzah Agustin, 2019 
MENGINTEGRASIKAN EMOTIONAL INTELLIGENCE KE DALAM AKTIVITAS OLAHRAGA 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

Berkenaan dengan teknik purposive, pada halaman 26 (Fraenkel et al., 2013) 

menyatakan bahwa:  

Researchers assume they can use their knowledge of the population to judge 

whether or not a particular sample will be representative..... Purposive sampling 

is different from convenience sampling in that researchers do not simply study 

whoever is available but rather use their judgment to select a sample that they 

believe, based on prior information, will provide the data they need. (hlm. 100) 

 

Berdasarkan pemaparan tersebut, dalam purposive sampling para peneliti 

berasumsi bahwa mereka dapat menggunakan pengetahuan mereka dalam menetukan 

kriteria populasi untuk menilai apakah suatu sampel tertentu akan mewakili 

penelitiannya atau tidak. Purposive sampling berbeda dengan convenience sampling 

di mana peneliti tidak hanya mempelajari siapa saja yang ada tetapi menggunakan 

penilaian mereka untuk memilih sampel yang mereka percayai, berdasarkan 

informasi sebelumnya, yang akan mewakili dan memberikan data yang mereka 

butuhkan.  

 Populasi adalah keseluruhan objek/subjek penelitian, oleh karena itu objek 

penelitian perlu ditetapkan secara akurat, sebab data yang terkumpul akan diolah dan 

dianalisa kemudian kesimpulannya digunakan untuk membuktikan kebenaran 

hipotesis. Populasi yang digunakan dalam penelitian ini yang diambil yaitu siswa 

ekstrakurikuler Bola Voli di SMP NU Kaplongan, Indramayu usia 12-15 tahun. 

 Sampel dalam sebuah penelitian merupakan kelompok yang bisa menyediakan 

informasi sesuai dengan kebutuhan penelitian, sedangkan populasi merupakan 

kelompok besar yang diharapkan bisa menjasi sampel itu sendiri (Fraenkel et al., 

2013). Teknik pengambilan sampel atau teknik sampling adalah suatu cara 

mengambil sampel yang repsentatif dari populasi. Pengambilan sampel ini harus 

dilakukan sedemikian rupa sehingga diperoleh sampel yang benar- benar dapat 

mewakili dan dapat menggambarkan keadaan populasi yang sebenarnya.  

Berkaitan dengan desain yang akan digunakan yaitu The Randomized Pretest 

Posttest Control Group Design sehingga dalam pengambilan sampel yang digunakan 

adalah teknik purposive sampling yang harus dilihat usia para sampel. Di peroleh 

sampel yang berusia 12-15 dengan total keseluruhan sampel adalah sebanyak 45 
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orang. Kemudian dari usia 12-15 tahun dibagi 3 kelompok, masing-masing kelompok 

(eksperimen 1) 15 orang, (eksperimen 2) 15 orang dan kelompok (kontrol) 15 orang.  

 

3.5 Instrumen Penelitian 

Dalam suatu penelitian diperlukan suatu alat untuk mengumpulkan data sesuai 

dengan apa yang kita harapkan. Untuk mengumpulkan data dari sampel penelitian 

diperlukan alat yang disebut instrumen dan untuk tercapainya sebuah penelitian yang 

sudah ditetapkan perlu didukung oleh data penelitian yang akurat, adapun untuk itu 

perlu digunakan alat pengumpulan data yang tepat. Sehubungan hal tersebut maka 

dalam penelitian ini menggunakan: 

 

3.5.1 Kecerdasan Emosional  

(Goleman, 2016, hlm 45) mengatakan bahwa yang dimaksud dengan kecerdasan 

emosional adalah kemampuan mengontrol diri, memacu, tetap tekun, serta dapat 

memotivasi diri sendiri. Kecakapan tersebut mencakup pengelolaan bentuk emosi 

baik yang positif maupun negatif. 

Untuk memperoleh data sesuai dengan apa yang diharapkan oleh penulis maka 

penulis menggunakan angket sebagai instrument penelitian kecerdasan emosi. 

Penyususanan soal angket disesuaikan dengan hal apa yang akan diteliti. Angket yang 

digunakan dalam penelitian ini mengadaptasi dan memodifikasi angket kecerdasan 

emosional dari Global Star Enterprises, sebuah lembaga yang bertujuan untuk 

memberikan konsultasi dan training dalam bidang psikologi. Angket ini pada 

dasarnya digunakan untuk mengungkap kecerdasan emosi 

Menurut psikolog Daniel Goleman terdiri dari lima indikator berdasarkan seperti 

selfawareness (kesadaran diri sendiri), self-regulation (pengendalian diri sendiri), 

motivation (motivasi), empathy (empati), dan social skills (keterampilan sosial). 
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Adapun langkah-langkah yang dilakukan dalam pengembangan instrumen adalah 

sebagai berikut : 

a. Menyusun kisi-kisi instrumen kecerdasan emosional 

Bacalah setiap elemen berikut dan kriteria terkait seperti yang ditentukan dalam 

Lima Elemen Kecerdasan Emosional Goleman. Di kolom sebelah kanan, pilihlah 

salah satu jawaban yang sesuai dengan apa ang anda rasakan dengan memberi tanda 

(√) pada kolom jawaban yang tersedia, yaitu seperti yang tertera pada halaman 28: 

1. : Sangat tidak setuju 

2. : Tidak setuju 

3. : Ragu-ragu 

4. : Setuju 

5. : Sangat setuju 

 

Tabel 3.2. Kisi-kisi Instrumen Kecerdasan Emosional 

Elemen / 

Deskripsi 

Kriteria Skor 

Kesadaran diri 

Mengetahui apa yang dirasakan seseorang pada waktu tertentu dan memahami dampak 

perasaan itu terhadap orang lain 

1. Saya dapat memahami emosi pribadi saya dengan baik. 1 2 3 4 5 

2. Saya memiliki kemampuan untuk tidak membiarkan 

emosi mengendalikan perilaku saya. 

1 2 3 4 5 

3. Saya bisa mempercayai pemikiran saya dan tidak 

membiarkan emosi saya lepas kendali. 

1 2 3 4 5 

4. Saya bisa melihat diri saya dengan jujur. 1 2 3 4 5 

5. Saya menyadari pemicu emosi saya juga kekuatan dan 

kelemahan. 

1 2 3 4 5 

Kontrol diri 

Mengontrol atau mengarahkan emosi seseorang; mengantisipasi konsekuensi sebelum 

bertindak berdasarkan dorongan hati 

6. Saya memiliki kemampuan untuk mengendalikan emosi 

dan dorongan hati - saya dapat berpikir sebelum 

bertindak. 

1 2 3 4 5 

7. Saya tidak membiarkan diri saya menjadi terlalu marah 

atau cemburu. 

1 2 3 4 5 

8. Saya tidak membuat keputusan spontan. 1 2 3 4 5 
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9. Saya memikirkan terlebih dahulu sebelum melakukan 

sesuatu. 

1 2 3 4 5 

10. Saya nyaman mengatakan 'tidak' kepada orang-orang. 1 2 3 4 5 

11. Saya nyaman saat menghadapi perubahan. 1 2 3 4 5 

Motivasi 

Memanfaatkan faktor-faktor emosional untuk mencapai tujuan, menikmati proses 

belajar dan bertahan dalam menghadapi rintangan 

12. Saya memotivasi diri. 1 2 3 4 5 

13. Saya bersedia menunda hal yang kecil untuk hal yang 

besar. 

1 2 3 4 5 

14. Saya selalu baik dalam pekerjaan saya. 1 2 3 4 5 

15. Saya menerima tantangan dan sering tampil baik di akhir. 1 2 3 4 5 

16. Saya menikmati belajar keterampilan dan pengetahuan 

baru. 

1 2 3 4 5 

Empati 

Merasakan emosi orang lain 

17. Saya dapat mengenali dan memahami keinginan, 

kebutuhan, dan sudut pandang orang lain. 

1 2 3 4 5 

18. Saya bisa mengenali perasaan orang lain, bahkan ketika 

perasaan itu mungkin tidak jelas. 

1 2 3 4 5 

19. Saya dapat berhubungan baik dengan orang-orang dari 

kelompok sosial atau budaya yang berbeda dari saya. 

1 2 3 4 5 

20. Saya memiliki kemampuan untuk membangun dan 

mempertahankan hubungan positif dengan orang-orang. 

1 2 3 4 5 

21. Saya seorang pendengar yang aktif, terlepas dari orang 

atau situasinya. 

1 2 3 4 5 

22. Saya menghindari meniru dan menghakimi orang lain. 1 2 3 4 5 

Keterampilan social 

Mengelola hubungan, menginspirasi orang lain dan mendorong respons yang 

diinginkan dari mereka 

23. Saya pemain tim yang kuat 1 2 3 4 5 

24. Saya menyadari kebutuhan tim dan orang lain, di atas 

kebutuhan saya sendiri. 

1 2 3 4 5 

25. Saya suka membantu orang lain tumbuh dan bersinar. 1 2 3 4 5 

26. Saya memiliki kemampuan untuk mengelola dan 

menyelesaikan konflik dengan baik. 

1 2 3 4 5 

27. Saya memiliki keterampilan komunikasi interpersonal 

yang kuat. 

1 2 3 4 5 
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b. Pedoman penilaian 

Instrumen dibuat dan disusun berdasarkan kisi-kisi yang telah dibuat dan 

menghasilkan item-item pertanyaan yang akan dijawab oleh para siswa yang 

mengikuti ekstrakulikuler Basket dan juga Futsal. Item dalam kuosioner digunakan 

untuk mengukur kecerdasan emosional dan alternatif jawabannya menggunakan 

Skala Likert. Kategori jawaban dan nilai skala dapat dilihat pada tabel yang tertera 

sebagai berikut: 

 

Tabel 3.3. Skala Likert 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sumber : Sugiyono (2016, hlm 135) 

  

3.6  Prosedur Penelitian 

Dalam sebuah penelitian diperlukan suatu prosedur penelitian guna menjaga 

sistematis dan memandu peneliti menuju pada tujuan penelitian. Penentuan metode 

penelitian, yang dalam penelitian ini menggunakan metode eksperimen dengan desain 

penelitian Pretest-Posttest Control Group Design With More Than One Experimental 

Group. Kemudian melakukan penelitian pada sampel yaitu siswa Ekstrakurikuler 

Olahraga SMP NU Kaplongan, penelitian dilakukan dengan melakukan pretest 

dengan memberikan angket emotional intelligence, diberikan treatment kepada 

kelompok eksperimen, setelah itu melakukan posttest dengan memberikan angket 

angket emotional intelligence, sehingga akan mendapatkan data yang akan dianalisis 

Kategori Jawaban Positif (+) Negatif (-) 

   

Sangat Setuju 5 1 

   

Setuju 4 2 

   

Ragu-ragu 3 3 

   

Tidak Setuju 2 4 

   

Sangat Tidak Setuju 1 5 
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dan diolah. Analisis data diawali dengan uji normalitas dan homogenitas yang akan 

dilanjutkan dengan analisis varians (ANOVA). Analisis data menggunakan SPSS 

25.0. Dan terakhir penarikan kesimpulan. Maka secara skematis langkah penelitian 

dibawah ini: 

 

 
 

3.7  Analisis Data 

Analisis Data yang digunakan dalam penelitian ini meliputi data yang diperoleh 

dari hasil pre-test dan hasil post-test. Data yang diperoleh dianalisis untuk menjawab 

pertanyaan penelitian. Analisis data bertujuan untuk mengungkap keefektifan 

Aktivitas Olahraga Sekolah terhadap Emotional Intelligence. 

   Adapun analisis data dalam penelitian ini menggunakan langkah-langkah 

pengolahan data yang tertera pada halaman 32: 
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3.7.1 Rata-rata dan Simpangan Baku 

Perhitungan rata-rata dan simpangan baku dengan menggunakan aplikasi 

Statistical Package for the Social Sciences (SPSS) versi 25. Tahapan penghitungan 

yang akan dilakukan dengan langkah-langkah sebagai berikut: klik 

Analyze>Descriptive Statistics >Descriptives> Masukan semua variabel ke kotak 

Variable(s) >Options> ceklis Mean dan Std. Deviation >Continue>OK. 

 

3.8  Uji Normalitas 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui apakah 

data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

kolmogorov-smirnov dengan bantuan Statistical Package for the Social 

Sciences(SPSS) versi 25. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah sebagai berikut: klik Analyze>Nonparametric Tests >Legacy 

Dialogs > 1-Sample K-S > Masukan semua variabel ke kotak Test Variable List >OK. 

Format pengujiannya dengan membandingkan nilai probabilitas (p) atau signifikansi 

(Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan normal. 

b. Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak normal. 

 

3.9  Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau sampel 

yang diambil berasal dari varian yang homogen atau tidak. Uji homogenitas 

dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas menggunakan Lavene 

Statisticdengan bantuan Statistical Package for the Social Sciences (SPSS) versi 25. 

Tahapan penghitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: 

klik Analyze>Compare Means>One-Way ANOVA> Masukan variabel ke kotak 

Dependent List > Masukan faktor ke kotak Factor >Options >Homogenity of 

variance test>Continue>OK. Format pengujiannya dengan membandingkan nilai 
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probabilitas (p) atau signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji 

kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan homogen. 

b. Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak homogen. 

 

3.10 Uji Hipotesis 

Uji hipotesis yang digunakan dalam penelitian ini menggunakan uji ANOVA dua 

jalur dengan bantuan Statistical Package for the Social Sciences (SPSS) versi 25. Uji 

hipotesis menggunakan analisis varians klasifikasi ganda, dalam penelitian ini 

menggunakan dua jalan (two way anova). Analisis varian digunakan untuk menguji 

hipotesis komparatif lebih dari dua sampel (k sampel) secara serempak bila setiap 

sampel terdiri atas dua kategori atau lebih (Sugiyono, 2017, hlm. 183).  

 

 


